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Trademarks 
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Instruction Symbols 
 

The following icons appear in the document: 

 

 

Note: Important additional information.  

 

 

Example: Practical illustration of a process or procedure. 

 

 

Tip: Suggestion or hint to guide or assist users performing a task. 

 

 

Warning: Warning against potential mistakes and actions that could cause critical error. 
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Introduction 
Congratulations on choosing Backup Pro Enterprise Server Edition. Backup Pro minimises risk, maximises productivity and 

allows businesses to regain control of their most valuable asset - their data. 

For technical support, please go to Help > About Redstor Backup Pro ESE, and then use the contact details provided. 

Product overview 
With Backup Pro Enterprise Server Edition (ESE), data stored on servers can be backed up to a Storage Platform quickly, 

securely and automatically. 

 

The following diagram illustrates the scenario: 

 

Data stored on one or more servers running ESE can be backed 

up to a Storage Platform. In the event of data loss or corruption 

on the server, you can retrieve data from the Storage Platform 

and restore it to the original or another server in just a few easy 

steps. 

 

A Backup Administrator can manage the entire backup 

environment (Backup Clients and the Storage Platform) 

remotely, using the Backup Pro Storage Platform Console. For 

more information, please refer to the Storage Platform Console 

User Manual. 

WebAccess 

The Backup Pro WebAccess browser-based application is not compatible with Backup Accounts created by the ESE Backup 

Client. It can however be used with the Desktop & Laptop Edition (DL) of Backup Pro. 

  

Storage Platform 

SE 

SE 

Storage Platform 

ESE 

ESE 
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1. Getting started 
Enabling manual or automatic backups is easy with Backup Pro Enterprise Server Edition: 

 

 

2. Installation 
For the latest system requirements and compatibility information, please refer to the System Requirements and 

Compatibility Matrix. 

The ESE MSI file contains pre-configured information to make installing ESE quick and easy. For more information on 

creating MSI files and launching them from the Run Command, please refer to the Storage Platform Console User Manual. 

 

Note: The options available during the installation process depend on the settings enabled by the 

administrator when the MSI file was created. These options range from advanced install settings to specifying 

the install location. The default install path is:  

C:\Program Files\Redstor Backup Pro\Backup Client ESE 

 

Warning:  

 If running antivirus software, please ensure that all Backup Pro folders are excluded from antivirus 

scans to avoid data corruption. 

 Both antivirus software scans and backup processes are resource-intensive. It is advised not to run a 

backup and virus scan at the same time as this will significantly decrease machine performance. 

 Windows will check whether you are running the MSI file suited to the installed operating system (i.e. 

32-bit or 64-bit) and will not allow you to install the wrong version. 

 The CPU of the client machine must support the “AES-NI” to leverage off performance benefits of 

the AES-GCM encryption algorithm. A message will be logged to indicate whether the client machine 

supports AES-NI 

To install Backup Pro ESE: 

1. Run the MSI file. 

2. In the Backup Pro ESE Setup Wizard that appears, follow the steps as described below. 

  

1. Install ESE
2. Create a Backup 

Account
3. Select files and 
folders for backup

4. Backup -
Automatically or 

manually
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Backup Pro ESE Setup Wizard 
The Backup Pro ESE Setup Wizard typically consists of five steps to guide you through the Setup task in a simple, step-by-

step manner. 

 

Note:  

 Some of the settings described below may have been removed when the MSI was created. 

Furthermore, the wizard may contain additional steps. Please read each window carefully before 

continuing. 

 If you receive a Windows User Account Control message, asking you if you wish to allow the Backup 

Pro installation program to make changes to the computer, click Yes to proceed. 

Step 1 of 5: Start the Backup Pro ESE Setup Wizard 

To start the Backup Pro ESE Setup Wizard:  

 

Click Next.  

Step 2 of 5: Specify a Windows user account 

To enable the Backup Client to read all files that must be backed up, it may be necessary for the Backup Client service to run 

under a specific Windows account.  

To specify which Windows account should run the backup service: 
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 Select Run as LocalSystem. 

 Alternatively, specify a specific Windows user account: 

1. Select Run under this user account. 

2. In the User Name box, type the Windows user name for the account. 

3. In the Password box, type the Windows user account password. 

4. Click the Validate button. 

5. Once the Windows user account has been validated, click Next.  

 

Warning: If specifying an account different than “LocalSystem”, please ensure that the user account in this 

step has full access to all files to be backed up. If files are included for backup that the account does not have 

access to, a “Some files were skipped” or “files skipped” error message will display in the backup logs. 

Step 3 of 5: Specify an install location 

To specify a destination for the ESE application files and folders:  

 

 Click Next to accept the default destination folder and continue to the next wizard step. 
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 Alternatively, specify a new destination folder: 

1. Click the Change button. 

2. Browse to the folder. 

3. Click OK. 

4. Click Next to continue to the next wizard step. 

Step 4 of 5: Begin the installation 

Once all the settings are configured, the wizard is ready to begin the installation.  

To begin the ESE installation:  

 

Click Install. 

Step 5 of 5: Exit the Backup Pro ESE Setup Wizard 

The last step of the wizard presents the option to launch the Backup Client.  

To launch the Backup Client immediately after the Backup Pro ESE Setup Wizard:   

1. Ensure that the Launch Redstor Backup Pro ESE check box is selected. 
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2. Click Finish.  

 

If you selected the Launch Backup Pro ESE check box in the last step of the Backup Pro ESE Setup Wizard, the Backup 

Client will open automatically upon clicking Finish and the Setup Wizard (which is the Backup Account Wizard and Backup 

Wizard combined) will launch, enabling you to create a Backup Account and configure your backup settings. Follow the 

wizard steps as described in Chapter 3, “Setup Wizard”. 

If you opted not to launch the Backup Client immediately, you can open the Backup Client at a later stage via the Start menu 

or by following any of the instructions listed under Opening the Backup Client in Chapter 5, “Graphical User Interface”.  

 

Note: The Setup Wizard will launch when you open the Backup Client for the first time. 
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3. Setup Wizard 
The Setup Wizard consists of the Account Wizard and Backup Wizard combined into one. It is used to set up a Backup 

Account (which is required for backing up) and configure your backup settings. The Setup Wizard runs automatically the first 

time the Backup Client is opened. You can run the standalone Account Wizard or Backup Wizard at any other time by clicking: 

 Tools > Wizards > Account Wizard 

 Tools > Wizards > Backup Wizard 

 

Note: If you run the Account Wizard, a warning box will appear. Click the Run Account Wizard button and 

follow the instructions. 

If you selected the Launch Backup Pro ESE check box in the last step of the Backup Pro ESE Setup Wizard (see The Backup 

Pro ESE Setup Wizard in Chapter 2, “Installation”), the Backup Client will run and display the Setup Wizard automatically.  

If the Launch Backup Pro ESE check box was not selected in the last step of the Backup Pro ESE Setup Wizard, the Setup 

Wizard will launch when the Backup Client is opened for the first time (for more information, see Opening the Backup Client 

in Chapter 5, “Graphical User Interface”).  

The Setup Wizard typically consists of seven steps to guide you through the setup task in a simple, step-by-step manner.  

 

Note: Some of the settings encountered in the wizard may have been removed when the MSI was created.  

Furthermore, the wizard may contain additional steps. Please read each window carefully before continuing. 

Step 1 of 6: Specify Storage Platform settings 

To specify the Storage Platform settings:  

1. In the Storage Platform address box, type the IP address or DNS name of the Storage Platform where the Backup 

Account resides.   

 

2. In the Backup Group box, specify which Backup Group the Backup Account belongs to.  

 

Note: Type the Group name in relation to any Collections it may belong to. For example: 

COLLECTIONA\COLLECTIONB\GROUP  
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3. In the Account Create Key field, specify the preconfigured Backup Account create key for the applicable Group. If 

you do not have access to this key, please contact your Storage Platform administrator. 

 

Note: This key is case sensitive. 

4. Once all the correct settings have been entered, click Next. 

Step 2 of 6: Create or connect to a Backup Account 

You can either create a Backup Account or connect to an existing Backup Account.  

To create a new Backup Account:  

1. Select I want to create a new Backup Account.  

 

2. Click Next. 

To connect to an existing Backup Account: 

 

Note: You can select I want to connect to an existing Backup Account to: 

 Connect to an Account that has been opened for use by this computer. 

 Reconnect to an Account to recover data from the computer that had previously backed up to this 

Account. 

1. Select I want to connect to an existing Backup Account.  

 

Warning: Different servers cannot back up to the same Backup Account. A separate Backup Account 

needs to be created for each server. 

2. Click Next to continue. 

Step 3 of 6: Specify Backup Account details 

Depending on the option you selected in the previous step, you will either be prompted to specify new Backup Account details 

or to supply the already configured details of the existing Backup Account.  

To specify new Account details: 
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1. In the Backup Account name box, type a Backup Account name that consists of a minimum of 4 characters.  

 

2. In the Backup Account password box, type a password that consists of a minimum of 4 characters. Confirm it in 

the Confirm password box. 

3. In the Encryption key box, type an encryption key that consists of a minimum of 8 characters. Confirm it in the 

Confirm key box. 

 

Warning: Please write down your encryption key and store it in a safe place as YOU WILL NOT BE 

ABLE TO RESTORE YOUR DATA WITHOUT IT. 

4. Click Next. 

When connecting to an existing Account:  

1. In the Backup Account name box, type the Backup Account name.  

2. In the Backup Account password box, type the Account password. 

3. In the Encryption key box, type the encryption key chosen when the Backup Account was created.  

4. Click Set up connection settings… if you’d like to configure your connection to the Storage Platform. 

5. Click Next.  

If connecting to an SE Account which has been newly converted to ESE 

 Backup Sets. All your previous SE backup sets will be collapsed into one i.e. all files will be available from a single 

backup set in ESE. 

 The first backup. Because existing backup data is preserved, the next backup will only send changes to the Storage 

Platform. However, this does not apply to WIB. (See the section Windows Image Backup in Chapter 9, “Options and 

Settings”.) 
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 Data backed up by plug-ins. All data backed up by plug-ins, such as “VSS” and “System State (using WSB)” will 

be available for restore. However, since these plug-ins are no longer available in ESE, new backups will need to be 

configured for these data sets. 

Step 4 of 6: Confirm Backup Account summary 

Confirm that the information you have supplied is 

correct, and then click Create or Reconnect, 

depending on whether you are creating a new 

Backup Account or connecting to an existing 

Backup Account.  

The Backup Client will connect to the 

AccountServer and configure your Backup 

Account. A message will be displayed confirming 

that your Backup Account has been successfully 

configured.  

The information will also be distributed to the 

relevant StorageServer. This is useful in case the 

AccountServer is unavailable, your backups will be 

able to continue uninterrupted. 

This is the last step of the Account Wizard. After your Backup Account is successfully configured, the Setup Wizard will 

immediately start the Backup Wizard to help you configure your backup settings. 

Step 5 of 6: Schedule backup process 

Backup Pro ESE Backup Client can take backups of included files and folders either upon request (manually) or automatically. 

This step enables you to set up an automatic backup schedule.  

 

Tip: We suggest backing up at night when the server is running but the Backup Client is not in use. The 

server must be switched on at the time(s) specified for scheduled backups, but the Windows user does not 

need to be logged in. 
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To configure the Backup Client to run only 

manual backups:  

 

Warning: This option is not 

recommended. If an automated 

backup schedule is not created, 

backups will have to be run 

manually. Enabling automatic 

backups is strongly advised. 

1. Clear the Daily automated backup and 

Advanced schedule… check boxes. 

2. Click Next to move to the next step in the 

wizard. 

To schedule a daily automated backup: 

1. Select the Daily automated backup 

check box. 

2. Specify a time in the associated box. 

3. Click Next to move to the next step in the wizard or create an advanced backup schedule as described below. 

To create an advanced backup schedule: 

1. Select the Advanced schedule (back up at the following times) check box. 

2. In the Week day box, select a day on which a backup should be initiated. 

3. Specify the time in the Backup time box. 

4. Click the Add button to add the day and time to the Advanced schedule box. 

5. Repeat the steps above until you have added all desired schedules. 

6. Click Next to move to the next step in the wizard. 

Step 6 of 6: Confirm backup configuration 

The wizard displays a summary of the choices you 

have made. It also shows the working folders which 

you can edit by clicking the edit... link.  

 

Note: If the drive on which the Backup Client is installed has limited space available, you can move the folders 

to another location. 

 

Status 
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Click Finish to complete the wizard. 

Congratulations 

You have now successfully completed the Setup 

Wizard. Click Next and select data to back up.  
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4. Updating Backup Clients 
Backup Clients are usually set up to be updated automatically but the process can be carried out manually. You’ll find a 

description of Auto Updates and a set of instructions on how to perform manual updates in the following sections. 

Automatic Updates 
Backup Pro allows you to automate the update process so that the Enterprise Server Edition Backup Client is updated with 

the latest software version during the backup process.   

Update packs are created for brand changes and core program updates respectively, and are distributed to the AccountServer. 

The AccountServer then distributes these to the different StorageServers from where they are requested during the backup 

process by the Backup Client. 

 

Note:  

 Auto Updates must be enabled on the Storage Platform for this feature to work. For more information 

on enabling Auto Updates, please refer to the Storage Platform Console User Manual. 

 By default, if there is less than 500 MB free space available, an update pack is not requested. This is 

logged to the Backup Service log. 

 Backup Clients are always updated to the latest version and service pack available from the Storage 

Platform. 

If a Backup Client update is available, one of the following will occur:  

1. If the Backup Client is open after a backup process has completed, you will be presented with an update dialog box. 

You have the option to update now or cancel:  

 

 Clicking Update now closes the Backup Client and installs the update. 

 Clicking Cancel closes the dialog box and does not install the update. The dialog box will appear again the next 

time you back up.  

2. If the Backup Client is not open, an automatic update check occurs in the following instances: 

 When an automated backup occurs, the update will be installed 

 An update is performed 10 minutes after the Backup Pro ESE service is restarted and then again every 24 hours 

after that 

After an Auto Update occurs containing core program updates, the Backup Pro ESE System Tray icon will display a 

notification indicating that the update was successfully applied and the new version number. 

Manual updates 
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To manually update ESE Backup Clients: 

1. Close the Backup Client and click Exit on the Backup Pro ESE system tray icon. 

2. Run the ESE Installer.  

 

Note: The ESE Installer retrieves the install location from the backup service and cannot be changed 

when you are upgrading an existing ESE Backup Client. 

3. On the Welcome screen, click Next: 

 

4. On the Ready to install Redstor Backup Pro ESE screen that appears, click Install: 

 

5. If the Backup Pro ESE service is running, you will be prompted that about Files in Use. Click OK to have the installer 

stop the service, update the software and then to restart the service.  
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6. If the ESE service is not running when the update is being performed, the installer will update the software and start 

the service automatically thereafter. 

7. On the Completion screen that displays, Launch Redstor Backup Pro ESE is selected by default. Clear the check 

box if you do not wish to do so. 

 

8. After the Backup Client updates, click Finish. 

 

Note: If prompted to restart the machine, note that it is not essential to do so since the ESE service 

would have been restarted already. 

9. Confirm that you can open the ESE Backup Client and that you can initiate a manual backup successfully. (see 

“Starting a backup manually” later in this document) 
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5. Graphical User Interface (GUI) 
By opening the Backup Client, you can use the Graphical User Interface (GUI) to:  

 Select files for backup and restores 

 Start backups and restores 

 Schedule automatic backups  

 Find files in previous backups 

 Restore files and folders from previous backups 

Opening the Backup Client 

To open the Backup Client: 

On the Start menu, click Redstor Backup Pro ESE.  

 

Alternatively, if the Backup Client is closed but the service is still running (the “Redstor Backup Pro ESE” icon is visible in 

the System Tray), double-click the Redstor Backup Pro ESE System Tray icon or right-click it, and then click Open: 

 

 

Note: The first time you open the Backup Client, the Setup Wizard launches automatically. For more 

information on creating a Backup Account, see Chapter 3, “Setup Wizard”. 

The GUI explained 
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You can manage and monitor backups using the Backup Client, the System Tray icon or the notification bubbles that appear 

when certain processes occur. Below are descriptions of each of these items and the options they provide. 

The Backup Client contains the following areas: 

 

The Backup Client will automatically detect installations that will automatically activate different views: 

 Microsoft SQL Server – the SQL view 

 Microsoft Exchange – the Exchange view 

 Capita SIMS, FMS and Discover – the SIMS, FMS and Discover views, respectively. 

  

Status bar 

Menu 

Toolba

Tabs 

Views 

Full 

System 

Backup 



 

 

23 

Copyright © Redstor Limited. All rights reserved 

Menu bar and toolbar buttons 

All Backup Client functions can be performed from the menu bar. Shortcuts to the most commonly used menu bar functions 

are also available on the toolbar and right-click menus. 

Menu bar 

Each menu on the menu bar contains one or more options. The tables below describe the options available.  

File menu 

Option Click the option to... Button 

Backup Initiate a backup immediately. 

 

Restore 

Switch to the Restore view in the Backup Client.  

 

Tip: For faster access to the Restore view, click the 

Restore tab instead of using the File menu. 

 

 

Calculate Size 

Determine the total size of the data included in the backup selection. For 

more information, see Determining the backup selection size in Chapter 6, 

“Backups”. 

 

Exit 

Close the Backup Client. 

 

Tip: You can re-open the Backup Client window at any 

time via the Windows Taskbar or by double-clicking the 

icon in the System Tray. 

 

 

Tools menu 

Option Click the option to... 

Automatic 

Backups 

Access the Backup Schedule settings in the 

Options and Settings dialog box. Configure the 

settings in the Automatic Backups area to set up 

one or more automatic backups. For more 

information, see Scheduling automatic backups in 

Chapter 6, “Backups”. 
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Option Click the option to... 

Wizards > Account 

Wizard 

Launch the Account Wizard, which is a 

standalone wizard that enables you to change 

your Backup Account settings. For more 

information, see Chapter 3, “Setup Wizard”. 

 

Wizards > Backup 

Wizard 

Launch the Backup Wizard, which is a 

standalone wizard that enables you to configure 

your backup settings. For more information, see 

Chapter 3, “Setup Wizard” 

 

Snapshot > Export 

Backup Snapshot 

Access the Export Backup Snapshot dialog box, 

which enables you to configure the next backup 

to be a Snapshot backup to a specific location. 

For more information, see Backup Snapshots in 

Chapter 9, “Options and settings”. 

 

Snapshot > Import 

Restore Snapshot 

Access the Import Backup Snapshot dialog box, 

which enables you to configure Restore Snapshot 

settings. For more information, see Restore 

Snapshots in Chapter 9, “Options and settings”. 

 

Options 

Opens the Options and Settings dialog box that 

enables you to modify a range of settings. For 

more information, see Chapter 9, “Options and 

settings”. 
 

Help menu 

Option Click the option to... Menu/Button 

Icon Legend 
Access a list of the icons used in the Backup Client 

and their meanings.  
 

About Redstor 

Backup Pro ESE 

Access the product information and support contact 

details. Also displays any plug-in version 

inconsistencies. 
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Icon legend 

On the Backup Selection and Restore tabs, each file and folder is displayed with an associated icon. The colour of the icon 

indicates the file or folder’s backup selection status.  

The icon legend lists the Backup Client icons 

and the statuses they indicate. You can access 

this legend by clicking Icon Legend on the 

Help menu. 

 

Note: For more information on backup and restore selections (inclusions and exclusions), see Views: The 

selection mechanism explained earlier in this chapter. 

Full System Backup switch 

A full system backup in Enterprise Server Edition ensures that all disks and 

therefore all data on the computer in question is included in the backup. 

See the section Performing a full system backup (for disaster recovery) in Chapter 

6, “Backups”, on how to do this. 

Once the data has been backed up, it can be restored to a virtual machine using 

the “Full System Recovery” option provided in the InstantData application (see 

the InstantData User Manual for details).  

Tabs 

There are three tabs available in the Backup Client:  

 Backup Selection: This tab displays the files and folders on 

the computer, enabling you to select the items to be backed up. 

 Restore: Use this tab to browse previous backups and restore 

files and folders. 

 Logs: Use this tab to view detailed information on each backup 

and restore. 

 

Tip: In the right-hand pane on the Backup Selection and Restore tabs, you can click any of the column 

headings to sort the list according to their values. 
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Views: Where to make selections 

Data from different sources is listed under respective views. Views are 

indicated on the left-hand side in the Backup Client.  

These views will automatically be displayed depending on whether the 

source has been detected on the computer. 

 

Note: The names of these views differ slightly between tabs 

the Backup Selection and Restore tabs. 

Adding Network Locations 

Add shared network locations or network volumes and include files in these locations in the backup selection. 

 

Warning: Please ensure that the backup service is started by a user with sufficient permissions to browse and 

access the network shares to be included in the backup selection. 

The Backup Client will only be able to back up files from a network volume after the share has been accessed and authenticated 

by the server on which the Backup Client is installed. 

 

Note: Only fixed and network drives can be backed up. Removable media cannot be backed up. 

To add a network volume: 

1. On the Network view, click Add Network Volume. 

 

2. In the Network Path box, type the network path, starting with "\\".  

 

Example: \\storageserver\documents  

Alternatively, use the Browse button to browse for the network location. 

Files in the network volume can now be included or excluded. (For more information on how to include and exclude files, see 

Selecting files and folders in Chapter 6, “Backups”):  

To remove a network volume from the Backup Client: 



 

 

27 

Copyright © Redstor Limited. All rights reserved 

1. Right-click on the entry in the left-hand pane. 

2. Click Remove  

The network volume will be removed from the left-hand pane. 

Views: The selection mechanism explained 

This is the main area where selections of data to be included in backups or restores are done inside their respective views as 

explained below. 

Implicit inclusions/exclusions 

Including or excluding parent-level item will explicitly include it and implicitly include its sub-items (the same applies to 

exclusions)  

Parent-level menu items – Include; Exclude: 

 

 

Example: Implicitly included sub-level items:  

 

 

Note: All files in the parent item will be included in the next backup which also means that any changes made 

within the parent item (such as a folder or database instance node) will automatically be included as well. 

Explicit inclusions/exclusions 

Excluding a child-level item will explicitly exclude it and its sub-level items, if any. The parent-level item will be displayed 

differently to indicate this.  

Sub-level menu items – Include; Exclude: 
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Example: An explicitly excluded sub-level folder: 

 

Removing parent-level inclusions/exclusions  

When a parent-level item’s inclusion or exclusion is removed, any explicit inclusions or exclusions will remain. 

 

Note: This is done by clicking the Include menu item on items that have already been included. 

 

Example: Parent-level inclusion removed; sub-level explicit exclusion remains: 

 

Clearing inclusions/exclusions 

Inclusions or exclusions or parent-level item inclusions can be undone by clearing them.  

Menu item: Clear 
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Removing offline items 

Files, folders and other items that have been backed up before, and are therefore still included in the backup selection, but no 

longer exist on disk, will be shown as “Offline”. They can’t be backed up any longer and can be removed by using the Remove 

option on the context menu in the Backup Selection tree (as above). 

 

Note: Your selection profile will be remembered by the Backup Client unless the Remove option was used. 

Status bar 

This area displays the status of the Windows service for the Backup Client. 

  

System Tray icon 

 The icon in the System Tray indicates the backup activity status and can be used to perform various tasks.  

 

 An animated icon indicates that the service is busy with a backup process. 

 Click or right-click the System Tray icon to view the menu options available: 
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Note: Depending on your Windows taskbar settings, the System Tray icon could be hidden by 

default. To display the icon, click the Show hidden icons arrow, click Customize notification icons. 

In the dialog box that appears, expand the Behaviours drop-down next to “Runner”, and then select 

Show icon and notifications. 

System Tray menu 

Options Click the option to... 

Open 

Opens the Backup Client. 

 

Tip: Users can also double-click the System Tray icon to open the application 

window. For more information, see “The GUI explained” earlier in this chapter. 

 

Backup Now Manually initiates the backup process without opening the Backup Client. 

Cancel Backup If the service is busy with a backup (when the icon is animated), Cancel will stop the process. 

Notifications 
Provides you with options to enable/disable backup notifications. For more information, see “Notifications” 

later in this chapter. 

About Displays the splash screen. Click anywhere in the window to close it. 

Exit 

Removes the icon from the System Tray.  

 

Note: This will not stop the Backup Pro ESE service from running scheduled 

backups. 

To see the icon in the System Tray again, simply open the Backup Pro Backup Client using the Windows 

Start button. For more information, see “Opening the Backup Client” earlier in this chapter. 

 

Warning: The backup service must be running at all times for backups (manual or scheduled) to take place. 

 

Note: To stop or start the Backup Service, open Administrative Tools in the Control Panel, and then 

double-click Services. In the list of services that appear, select Redstor Backup Pro ESE and select Stop or 

Start on the toolbar.  The System Tray icon will also indicate when the service is not running. 

Notifications 

Notifications of Backup Client activity will appear as pop-ups in the System Tray.  

 

 



 

 

31 

Copyright © Redstor Limited. All rights reserved 

The following notifications will appear by default but can also be disabled:  

1. When a backup completed successfully. 

2. When a backup failed to complete. 

3. When a backup was completed but there 

were warning or errors. 

 

Tip: To view related log file information, click anywhere within the pop-up. 

 

Note: You will always be notified when:  

 The Backup Client has been upgraded  

 After files have been restored 

To enable or disable notifications: 

Right-click the System Tray icon and then select the relevant Notifications option. 

 

Tip: Since notifications only appear briefly, hover over the System Tray icon to see when the last backup 

occurred. 

 

  

1 

2 

3 
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6. Backups 
After creating a Backup Account, you can set the Backup Client to back up or ignore specific files and/or folders by creating 

a backup selection. You can then start a backup manually or schedule automatic backups. 

How to back up 
The following sections describe how to: 

 Select data to back up (including files, databases and system-critical information) 

 Use advanced methods like filters and global exclusions to specify files and/or folders to be excluded from the backup 

selection. 

 Determine the backup selection size 

 Start backups – manually or automatically 

 Cancel or resume a backup 

a) Selecting files and folders 

All files and folders can be selected for backup from the Computer view. 

To proceed, perform selections for your backup. Refer to the section Views: The 

selection mechanism explained above. 

 

Tip:  

 Use other views when available for better performance during backups. 

 Use filters to automate file selection based on file types. See Using filters in this chapter  

 

Warning:  

 If you have limited space on the drive running the Backup Client, it is recommended that you move the 

Data and Logs folders to another location.  

o For more information, see Disk Usage in Chapter 9, “Options and settings”. 

o To confirm the size of the next backup, see Determining the backup selection size later in this 

chapter. 

 For Windows 2012 and above, we recommend disabling volume-level deduplication and compression 

as it could negatively affect backup performance. 

 

Note: Some files and directories are forcefully excluded from the backup selection. On Windows machines, these 

are the pagefile.sys and hiberfil.sys files and also the Backup Client’s folders, data and tasks. For more 

information about the Backup Client’s data folder, see the section Disk Usage in Chapter 9. 

b) Selecting SQL Server databases 
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Microsoft SQL Server® databases can be backed up (using the SQL view). Virtual Shadow 

Copy (VSS) technology is used to achieve this by reading files locked or occupied by other 

applications – such as an active database.  

 

Note: The SQL view is only visible if a running “SQL Server VSS Writer” 

service has been detected. 

To proceed, perform selections for your backup. Refer to Views: The selection mechanism 

explained above. 

 

Warning: Offline databases included will cause the backup to fail. Exclude the database to ensure the backup 

completes. 

 

Note:  

 Databases detached from the SQL Server instance will not be displayed in the Backup Selection and 

need to be backed up from the Computer view. 

 Files associated with SQL Server databases can be backed up individually. If databases files are also 

selected from the Computer view and an existing selection of a database exists in the SQL view, only 

one copy of the database will be backed up. 

c) Selecting Exchange mailbox databases 

Microsoft Exchange® mailbox databases are backed up 

using Virtual Shadow Copy (VSS) technology which is 

able to reading files typically locked by an application 

– such as databases.  

 

Note: The Exchange view will only be visible if the “Microsoft Exchange Information Store” (for Exchange 

2010) and the “Microsoft Exchange Replication” (for Exchange 2010 & 2013) Windows services are running. 

An overview of database states in the Backup Client 

Active and passive databases 

The replicated databases in Database Availability Group (DAG) 

will be indicated as “passive” in the Backup Selection tree. For 

stand-alone Exchange servers, all databases are indicated as 

“active”. 

To view:  

Just hover the mouse pointer over the Mailbox node to distinguish active mailbox databases from passive ones. 

Example of a passive database 

Database 

nodes 
Exchange 

view 

Server 

node 
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Online and offline databases 

Mailbox databases can appear as “Offline” in the Backup Selection 

tree for different reasons, such as a stopped Exchange Windows 

service or if the database has been dismounted.  

When offline databases are included in the backup selection, they will 

be skipped during the backup process. The result is also reflected in 

the backup log. 

However, if the Server node is included, the skipped database will be backed up if it is online at the next backup.  

 

Note: Dismounted mailbox databases will be seen as offline by the Backup Client on a Microsoft Exchange 

2010 server. 

 

Tip:  

 If Full System Backup has been enabled, you can exclude all databases of a SQL server to prevent 

those from being backed up. 

 While in the Backup Selection tab, press F5 to refresh your view of the backup selection. 

d) Including system-critical information (for disaster recovery) 

To perform Windows Image Backups (WIB), this setting needs to be enabled. To enable WIB, refer to the section Windows 

Image Backup, in Chapter 9, “Options and Settings”.  

e) Selecting Capita SIMS, FMS & Discover data 

For more information about backing up Capita components with ESE, refer to Capita SIMS, FMS, and Discover in Chapter 

10, “Advanced tools”. 

f) Performing a full system backup (for disaster recovery) 

A full system backup in Enterprise Server Edition ensures that all disks and therefore all data on the computer in question is 

included in the backup. 

Once the data has been backed up, it can be restored to a virtual machine using the “Full System Recovery” option provided 

in the InstantData application (see the InstantData User Manual for details). 

Turning on Full System Backup 

To turn on Full System Backup: 

On the Backup Selection tab, click the switch to ON. 

Example of an offline database 
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The following will happen: 

1. All files and folders in the Backup Selection tab are now marked as included (through icon colouring) for a full 

system backup (by the “flag” icon):  

 

2. Data from other views such as Network, Exchange and SQL, will also be included automatically. 

 

Note: For more information, see Views: The selection mechanism explained in Chapter 5, “Graphical User 

Interface”.  

Turning on Full System Backup 

To turn off Full System Backup: 

On the Backup Selection tab, simply click the switch again to OFF. 

 

Any backup selections made before enabling Full System Backup will be applicable again i.e. all files and folders previously 

included and excluded will be part of the next backup. 

Other selection methods (advanced) 

Using filters 

You can use filters to automate file inclusions or exclusions within a folder, based on file types. 
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Example: A *.docx filter will include or exclude all Word documents within a folder, as well as any new Word 

documents that are added to that folder later. 

To apply a predefined filter to a specific folder: 

1. In the Backup Selection tree, right-click the folder icon. 

2. Select Filters.  

 

3. Select one of the available filters in the list (e.g. MS Office documents). 

4. Click Include or Exclude. 

To modify an existing filter: 

1. In the Backup Selection tree, right-click the folder icon, select  Filters, then click Manage filters. 

2. Select one of the filters and then modify its properties in the File Extensions box. 

 

3. Click Save. 

4. Click OK. 

 

Tip: To add a new filter from within the Edit filters dialog box, click the New button, supply a name that 

describes the filter, enter the file type(s), and then click OK. 

To add a new filter via the Backup Selection tree: 

1. In the Backup Selection tree, right-click the folder icon, select  Filters, then click Manage filters. 
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2. Click Add New. 

 

3. In the Filter name box, type a name to be used in the Filters menu. 

4. In the File Extensions box, specify the file extensions to which the filter will apply. 

 

5. Click Save. 

6. Click OK. 

The filter will be added to the Filters menu and you will be able to use it to include or exclude all files matching its criteria. 

 

To remove filters from a folder: 

1. Right-click the folder icon. 

2. Select  Filters. 

3. Select the name of the filter you wish to remove. 

4. Clear the check mark next to the selection (Include or Exclude). 

To identify files and folders selected by filters: 
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Look at the icon state. Files and folders included in the backup selection by filters display with icons containing check marks. 

See the section Icon legend above for details.  

Inclusions and exclusions by “profiling” 

Some inclusions and exclusions are enforced by a Backup Administrator on the Storage Platform. This is called “profiling”. 

For more information, see Profiling in Chapter 9, “Options and settings”. 

Files and folders affected by profiling display with corresponding icons. For more information, see the Icon legend section 

later in this chapter. 

 

Note: Profiled selections cannot be modified from within the Backup Client and can only be changed on the 

Storage Platform. For more information, please refer to the Storage Platform Console User Manual. 

Global exclusions 

Global exclusions enable you to specify files and/or folders to be excluded from the backup selection.  

To add Global Exclusions: 

1. Click the Options button on the toolbar, and then click Global Exclusions. 

2. Select the type(s) of filters to apply and then specify their values. (For more information, see Global Exclusions in 

Chapter 9, “Options and settings”.) 

3. Click OK. 

Determining the backup selection size 

It is useful to determine the backup selection size before starting the backup process to avoid Over Limit errors. 

To calculate the backup selection size:  

A. On the File menu, click Calculate Size.  

B. Alternatively, click the Size button on the toolbar: 

 

The Backup Selection Size dialog box that appears displays total size of your backup selection (i.e. all files included for 

backup). 

 

Note: If Microsoft SQL Server databases are included in the backup selection on the instance level from the 

SQL view, the calculation only considers databases that are online. 

 

Warning:  
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 The Backup Client will log a warning if your backup selection size exceeds your Backup Account 

limit during a backup. You should remove some items from the selection or ask your backup 

administrator to increase your Account limit. 

 Disks with less than 10% space available for a restore will be indicated by a warning in the Backup 

Log at the start of each backup process. 

 If a backup fails and an Out of Memory error message is recorded in the backup log, you need to 

increase the default amount of server memory you wish to allocate to the backup service. 

To remove a file from the backup selection: 

A. In the Size dialog box, right-click the file’s icon.  

The icon will turn red to indicate that it is excluded.  

 

Note: To exclude multiple files at once, click a file name in the list, hold down the Shift key and drag 

the mouse pointer to highlight the files. Right-click the selection, and then click Exclude. 

B. Alternatively, on the Backup Selection tab, deselect or exclude 

files or folders that are currently selected for backup. For more 

information, see Selecting files and folders in Chapter 6, 

“Backups”. 

To cancel the backup selection size calculation:  

A. In the Size dialog box, click the Cancel button.  
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Starting a backup manually 

 

Note: Any changes, additions or deletions to included files and folders will be backed up intelligently with every 

manual or scheduled backup. 

 

Tip: Run a backup manually after creating the backup selection to ensure immediate data transmission to the 

Storage Platform. Thereafter, automatic backups will ensure hassle-free continuous backups. For more 

information, see Scheduling automatic backups later in this chapter. 

The backup log will indicate whether it was started manually or automatically via schedule. 

 

To start a backup manually: 

1. On the File menu, click Backup Now. Alternatively, click the Backup button on the toolbar. 

 

2. To close the Backup Client after the backup process has started, click the Hide button.  This will not cancel the 

backup process and the Backup Client can be re-opened at any time to view the progress of the backup. 

 

Tip: To view backup logs, click the Logs tab. Backup log dates are displayed in blue. 

 

Backup Status window  

The Backup Status window 

displays relevant information 

about backups that are either in 

progress or completed. The 

numbered elements indicated in 

this diagram are explained below. 

 

Note: The title of the 

Backup Status window 

changes according to 

the status of the 

backup process. 

Backup Progress: 

PREPARING 

The initial phase of a backup process has the following information displayed: 

1. No data is being transferred therefore the speed is shown as zero 
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8. Status of the current backup process i.e. “PREPARING” 

Backup Progress: PROCESSING 

A backup process in progress has the following information displayed:  

1. Total size of backup items processed thus far; backup processing speed; backup processing duration 

(dd:HH:mm:ss) 

 

Note: Size and speed indicators 4 and 5 are of data transferred to the Storage Platform only and do 

not relate to actual backup processing i.e. disk scanning, file encryption, etc. 

2. Backup start time 

3. Number of changed and unchanged folders already processed for backup  

4. Data transfer speed to Storage Platform 

5. Data already transferred to the Storage Platform (excluding the backup index) 

6. Number of changed and unchanged files already processed for backup 

7. Progress bar indicating processing progress per file 

 

Note: Additional progress bars will be displayed for each volume included in the backup e.g. D:, E:, 

F:, etc. except where volumes span across multiple disks, volumes on these disks will be processed 

afterwards. 

8. Status of the current backup i.e. “PROCESSING” 

Backup Progress: COMPLETED 

A completed backup process 

displays the following (as per the 

points indicated in the diagram 

above):  

1. Total size of backup items 

processed thus far; average 

processing speed during the 

backup; backup duration 

(dd:HH:mm:ss) 

2. Backup start time 

3. Total number of folders 

processed for backup 

4. Average data transfer speed to Storage Platform 

5. Data transferred to the Storage Platform (including the backup index) 

6. Total number of files processed for backup 

7. (No progress bars are displayed) 
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8. Status of the current backup i.e. “COMPLETED” 

Other Statuses 

 The status will also briefly be indicated as “DUMPING” if Windows Image Backup has been enabled. See 

the section Windows Image Backup, Chapter 9, “Options and Settings”. 

 The status will briefly be indicated as “RUNNING SCRIPT” if any scripts have been enabled on the Backup 

Scripts page. See the section Backup Scripts, Chapter 9, “Options and Settings”. 

Cancelling a backup 

Once a backup is in progress, you can cancel the process via the Backup Status window or by using the System Tray icon. 

To cancel a backup: 

1. In the Backup Status window, click the Cancel button. 

 

The status will change to “CANCELLING” while the Backup Client attempts to cancel the backup process. 

 

2. Alternatively, right-click the icon in your System Tray, and then click Cancel Backup. 
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3. In the confirmation dialog box that appears, click Yes. 

 

The backup will be cancelled and 

the status will be indicated as 

“CANCELLED” in the Backup 

Status window. This will be 

reflected in the backup Logs 

accordingly. Click the  button 

(pt. 9 in the image) to view the 

Logs. 

 

 

Note:  

 When a backup is cancelled by a user, it is considered a failed backup. 

 When a backup is cancelled by the Backup Administrator via the Storage Platform Console, this will be 

visible in the Backup Log. 

Resuming a backup 

 

Note: Once a backup process has been cancelled, it cannot be resumed. A new backup needs to be initiated. 

By default, the Backup Client tries to connect to the 

Storage Platform 10 times every 60 seconds in the case of 

a connection to the Storage Platform being lost. The status 

will be indicated as “RETRYING”.  
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If a connection cannot be re-

established, the backup process is 

automatically cancelled. The status 

of the backup will then be indicated 

as “FAILED” on the Backup Status 

dialog: 

When a backup fails unexpectedly, 

the details of a possible cause can 

be found in the backup Log. Click 

the  button (pt. 9 in the image 

above) to view the Logs. 

Scheduling 

automatic backups 
Automatic backups are usually enabled and configured either during the Setup Wizard or during the Backup Wizard but you 

can enable and schedule them at any point in time using the Options and Settings dialog box. 

 

Note: The backup log will indicate whether it was started manually or automatically. 

To schedule a daily automated backup: 

1. On the Tools menu, click Options. Alternatively, click the Options button on the toolbar. 

2. In the Options and Settings dialog box, click Backup Schedule. 

3. Select the Daily automated backup check box, and then specify a backup time in the associated box. 

4. Click OK. 

To create an advanced backup schedule: 

1. Select the Advanced schedule (back up at the following times) check box.  

2. In the Week day box, select the day on which a backup should be initiated.  

3. Specify the time in the Backup time box.  

4. Click the Add button to add the day and time to the Advanced schedule box.  

5. Repeat steps 2 to 4 above until you have added all desired schedules to the Advanced schedule box.  

 

Tip:  

 You are advised to back up at night when the server running the Backup Client is not in use. 

It must be switched on at the scheduled backup time(s), but the Windows user does not need 

to be logged in. 

 Configuring automatic backups ensures that all selected data is backed up automatically, 

without the need for any user interaction. This is more reliable than manual backups. 
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Backups will initiate at the scheduled times and if the Backup Client is open the Backup Status window will also appear 

displaying the progress of the backup: 

 

 

Tip:  

 To close the Backup Client after the backup process has started, click the Hide button.  This will not 

cancel the backup process and you can re-open the Backup Client at any time to view the progress of 

the backup. 

 To view backup logs, click the Logs tab. Backup log dates are displayed in blue. 

Backups will be stored on the Storage Platform and are accessible via the Restore tab. For more information on restoring data, 

see Chapter 7, “Restores”. 
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7. Restores  
On the Restore tab, you can browse a tree structure representation of all previous backups’ files and folders. 

How to restore 
The following sections describe how to:  

 Select the backup date 

 Select data to restore 

 Start the restore process 

 Cancel the restore process 

Selecting your data to restore 

Selecting the backup date 

To select the desired backup 

1. First, select the relevant view based on the type of data you need. In this example, the Files view contains the relevant 

data:  

 

 

Note: If a backup contains Microsoft SQL Server or Exchange mailbox databases, for instance, 

additional views will be visible. 

2. Then select the date on which your files were backed up. 
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Proceed by selecting the appropriate data to be restored. Based on the type of data you need, follow the procedures described 

below. 

a) Selecting files and folders 

On the Restore tab, the tree structure gives you access to backed up files relevant to the selected backup date. Be sure to 

navigate to the Files view.  

Including files and folders 

To include your data from the backup: 

1. Include a single file or an entire folder by clicking the icon next it or by right-clicking the file/folder name and then 

clicking Include. Each included item is displayed with a green icon. 

 

2. Once all the files and folders to be restored are selected, start the restore process by clicking Restore on the File 

menu or the Restore button on the toolbar. For information on the restore options available, see Starting the restore 

process later in this chapter. 

Excluding files and folders 

To exclude certain files and folders from being restored: 

1. If an entire folder is included but you wish to exclude a particular file or subfolder, right-click the file or folder icon, 

and then click Exclude . 
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Excluded items are displayed with red icons. Included folders that have some files or subfolders excluded are green 

with a red accent. 

2. Once all the files and folders to be restored are selected, start the restore process by clicking Restore on the File 

menu or the Restore button on the toolbar. For information on the restore options available, see Starting the restore 

process later in this chapter. 

b) Selecting SQL Server databases 

Microsoft SQL Server® databases are restored within an active SQL 

Server instance with the necessary metadata intact. Follow the steps 

below, while in the SQL view on the Restore tab, to select the appropriate 

databases to be restored.  

 

Note: The SQL view is only visible if a running “SQL 

Server VSS Writer” service has been detected. 

Including databases and instances 

Database selections can be done individually or on instance level. 

To select a database or instance:  

1. Right-click the folder icon of the database or instance. 

2. Click Include. 

The icon of the database or instance will change to green. If an instance was selected, the subordinate databases will also be 

included implicitly (see the section below, Excluding databases included implicitly). 

Excluding databases 

To clear the database or instance inclusion:  

1. Right-click the green folder icon of the included database 

2. Click Include again. 
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The database or instance icon will change to back to an unshaded icon. 

Excluding databases included implicitly 

To exclude databases included implicitly on instance-level:  

1. Right-click the green folder icon of the included database  

2. Click Exclude. 

The database icon will change to red and the instance's icon will change to green with a red accent. 

 

Note: The “master” database can only be restored from the Files view. For more information, see Selecting 

files and folders in Chapter 7, “Restores”. 

c) Selecting Exchange mailbox databases 

To select the files and folders of an Exchange server: 

Open the Files view to restore files of the Exchange server and relevant mailbox databases. Browse for the files as you would 

normally, as described in Selecting files and folders. 

 

Note: Files restored that were not backed up in the last backup will be indicated as such in the Restore log. 

 

Warning: Unless a mailbox database is inactive at the time of being restored, its files should be restored to a 

location different from the original backup location. 

d) Restoring system-critical data from a Windows Image Backup (disaster recovery) 

If Windows Image Backup (WIB) was enabled, all critical information for the system to function properly would have been 

backed up. This backup can be restored to gain access to all disk volumes required to restore a server to operational capability 

– especially to assist in disaster recovery.  

To enable WIB, see the Enabling Windows Image Backups in Chapter 9, “Options and Settings”. 

 

Note: The process described below assumes that, if used in a disaster recovery scenario, the Backup Client 

has been reconnected to the appropriate Backup Account (using the Account Wizard). 

Include the WindowsImageBackup folder 

To include the WIB folder for restore: 

1. In the Restore tab, identify the appropriate backup to be restored i.e. Last Backup or Previous Backup. 

2. Select the drive letter where the Windows Image Backup has been stored - this corresponds to the Dump destination 

specified in the Options and Settings of the Backup Client under Windows Image Backup. 
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3. Include the entire WindowsImageBackup folder by right-clicking the folder and then clicking Include folder. The 

included folder is displayed with a green folder icon. 

 

Example: Include the corresponding drive letter in your Restore selection: 

 

Starting the restore process 

In order for the WindowsImageBackup folder to be restored to a desired location, follow the steps as per Starting the restore 

process in Chapter 7, “Restores”. 

 

Note: If restoring to a location different to what was used during backup, the original Dump destination will 

be name of the folder on the new drive. For example: Dump destination volume “Z:” restored to volume “F:” 

will result in “F:\Z_\WindowsImageBackup”. 

After restoring, move the WIB folder to the root. For example: “F:\WindowsImageBackup” 

Once the folder has been restored, Microsoft’s Windows Server Backup and the Windows installation program can be used 

to perform various recovery methods. Two options are described below. 

Post-restore option 1: Recovery using Windows Server Backup (WSB) 

 Perform a full system recovery (a Bare Metal Restore/Recovery) from a network share, mobile storage 

media or local disk. 

 Perform a system state recovery i.e. it restores primarily the operating system components to their previous 

functioning states and not a full system recovery. 

 Perform component-level recovery e.g. Active Directory, IIS, etc. This does not perform a full system 

recovery. 

Post-restore option 2: Recovery using the Windows installer 

Perform an image-based recovery from a network share or mobile storage media where the WindowsImageBackup 

folder is located. 

 

Tip: If it is not possible to reconnect a server to the original backup account, the InstantData’s 

Temporary File Access option available on the Storage Platform Console allows an entire backup to 

be mounted as a virtual drive. Providing access to the data it contains, this drive letter can be 

shared and accessed remotely. Consult the InstantData User Manual for details.  
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Note: Please refer to the Knowledge Base for details on executing the above procedures. 

e) Selecting Capita SIMS, FMS, and Discovery information 

To select the files and databases of Capita components: 

Open the Files view to restore files of the Capita components and related databases. Browse for the files as you normally 

would, as described in Selecting files and folders. 

 

Note: To find the database files of the Capita components, check your Backup Configuration used when the 

databases were selected for backup. See SIMS databases in Chapter 10, “Advanced tools”. 

For information about backing up SIMS, FMS and Discover information, refer to Capita SIMS, FMS, and Discover in Chapter 

10, “Advanced tools”. 

f) Recovering an entire server (disaster recovery) 

For more information on how to recover an entire server as a virtual disk for use in a virtual machine, refer to the InstantData 

User Manual. 

g) Restoring archived data 

Backup Pro allows Backup Administrators to archive Backup Clients’ data to 

tape or another disk drive using the Hierarchical Storage Management (HSM) 

feature. Once data has been archived, the backups will display in the Restore 

tree as greyed out folders, allowing you to browse the file/folder structure of the 

backups.  

 

Note: Grey folders indicate archived data. However, if you do 

not see these folders in the Restore tree, it does not mean that 

no archived backups are available. In such cases, please 

consult your Backup Administrator about archived backups. 

You can access archived data by requesting that your Backup Administrator 

import the HSM data to the Storage Platform. Once the data has been imported, 

it will be available for restore in the same manner as all other backups. 

Starting the restore process 
After you have selected the data to restore, start the restore process as described below, either for files and folders or for 

databases. 
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Note: Disks with less than 10% space available will be indicated by a warning in the Backup Log at the start 

of each backup process. 

To start the restore process:  

1. While on the Restore tab, from the File menu, click Restore. Alternatively, click the Restore button on the toolbar: 

 

2. The Restore dialog box will prompt you for a restore location: 

  

3. Select Original location to restore the files to the same location that they were backed up from or select Folder and then 

browse to a new location.  

 

Warning:  

 If Original location is selected, the restored files will overwrite any existing files with the 

same name in that location. 

 Data backed up from folders that reference mounted volumes, will not be restored unless the 

appropriate volume is mounted and the referencing folder is intact. 

 

Note about restoring SQL Server databases:  

 The Restore Databases dialog box will prompt you whether existing databases should be 

overwritten: 

 

 You can view restore logs on the Logs tab. Restore log dates are displayed in green.  

 Databases can only be restored to machines with the same name as they were backed up from. 

 Database files restored from the Computer view which were detached since backup will need 

to be attached to the SQL Server instance manually. 

4. Click the Show advanced options... link to display the advanced restore options. You can now specify the rest of the 

restore options by selecting or clearing the following check boxes:  
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a. Restore file and folder permissions – Clear this check box if you do not wish to restore the file and folder 

permissions and ownership settings. You would typically only select this option after a complete server failure 

(to restore files before user accounts are re-created). 

b. Overwrite files – If this option is not selected, files that already exist will merely be skipped and will not be 

overwritten. This will be reflected in the restore Logs accordingly.  

5. Click Restore.  

 

Note:  

 You can view Restore logs on the Logs tab. Restore log dates are displayed in green. 

 The folder structure will automatically be recreated.  

 

Tip: To close the Backup Client after the restore process has started, click the Hide button on the Restore 

Status window.  This will not cancel the restore process and you can re-open the Backup Client at any time to 

view the progress of the restore. 

 

Restore Status window  

The Restore Status window displays relevant 

information about restores that are either in 

progress or completed. The numbered 

elements indicated in this diagram are 

explained below (as with the Backup Status 

window but with the exception of points 4 and 

5). 

 

Note: The title of the Restore 

Status window changes 

according to the status of the 

restore process. 

Restore Progress: 

PREPARING 

The inititial phase of a restore process has the following information displayed:  

1. No data is being transferred therefore the speed is shown as zero 

8. Status of the current restore i.e. “PREPARING” 

Restore Progress: IN PROGRESS 

A restore process in progress has the following information displayed:  

1. Total size of restored thus far; restore speed; restore duration (dd:HH:mm:ss) 
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2. Backup start time 

3. Number of folders already restored 

6. Number of files already restored 

7. Progress bar indicating restoration progress of the current file 

8. Status of the current restore i.e. “IN PROGRESS” 

 

Note: If the restore process is interrupted or a connection to the Storage Platform is lost, the status 

will be indicated as “RETRYING” while the Backup Client attempts to re-establish a connection and 

resume the restore process. 

Restore Progress: COMPLETED 

A completed restore process has the following information is displayed (as per the points indicated in the diagram 

above):  

1. Total size of the restore; average 

processing speed during the restore 

process; restore duration (dd:HH:mm:ss) 

2. Restore start time 

3. Total number of folders restored 

6. Total number of files restored 

7. (No progress bars are displayed) 

8. Status of the restore process i.e. 

“COMPLETED” 

Cancelling a restore 
Once a restore is in progress, you can cancel the process via the Restore Status window. 

To cancel a restore: 

In the Restore Status window, click the Cancel button. 

The status will initially be indicated as “CANCELLING” while the Backup Client attempts to cancel the restore process.  
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Once the restore is cancelled, the status will be indicated as “CANCELLED” in the Restore Status window. This will be 

reflected in the restore Logs accordingly. Click the  button (pt. 9 in the diagram) to view the Logs. 

 

Note:  

 When a restore is cancelled by a user, it is considered a failed restore. 

 When a restore fails unexpectedly, the details of a possible cause can be found in the restore Log. 

  



 

 

56 

Copyright © Redstor Limited. All rights reserved 

8. Logs 
The Backup Client logs all backup and restore processes and their results in log files that you can view on the Logs tab. The 

following sections describe how to access log files and modify their settings. 

Accessing log files 
The Logs tab in the Backup Client provides detailed information about each backup and restore.  

 

An additional toolbar button appears when the Logs tab is opened: the Summary button. Use the button to view only errors 

and warnings and the last few lines in the log file. 

 

 

Tip: You can use the Up arrow, Down arrow, Page Up, Page Down, Home and End keys to navigate the log. 

Changing log file settings 
You can specify your logging preferences on the Logging page in the Options and Settings dialog box.  

Modifiable settings include: 

 log file location 

 level of detail included 

 date inclusion/exclusion in time stamp 

 log file retention period 

For information on configuring the log file settings, see Logging in Chapter 9, “Options and settings”.  
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9. Options and settings 
To access the Options and Settings dialog box: 

 On the Tools menu, click Options.  

 Alternatively, click the Options button on the toolbar: 

 

The various options and settings are grouped in the left-hand pane according to their functions. Click an item on the left to 

view the full set of options related to that function. 

 

Warning: The Options and Settings dialog box controls advanced features in the Backup Client. Please read 

through this section carefully before changing any settings. Incorrect settings could cause critical errors. 

Backup Account 
You can use the Backup Account page in the Options and Settings dialog box to: 

 Retrieve Backup Account settings  

 Modify security settings  

 

The Backup Account page consists of the following areas: 
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 Details 

 Security 

Details area 

This area displays your Backup Account information as it is configured on the Storage Platform. You can use the Retrieve 

settings button to retrieve your Backup Account details from the Storage Platform. 

 

Tip: This button is useful to verify that the Backup Account limit has been modified after requesting a change 

from the Backup Administrator, or to update Backup Group Profiling settings. 

Security area 

If you need to change your password or encryption key, click the Change password or Change encryption key buttons. 

 

Warning:  

 Changing the encryption key involves intensive processing on the Storage Platform and may take 

several minutes. You should avoid doing this unless the encryption key has been compromised. 

 Disaster recovery is not possible without the encryption key. Please ensure that this key is kept in a 

safe place. THIS ENCRYPTION KEY IS NOT STORED ON THE STORAGE PLATFORM AND 

CANNOT BE RECOVERED OR RESET IF LOST. 

Email Notifications 
You can use the Email Notifications page in the Options and Settings dialog box to receive email notifications after a backup 

has taken place. 

  

 

You can select one of three conditions for when this will occur: 

1. Failed backups only: only when a backup has failed 
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2. Failed backups, errors or warnings: 

when a backup has failed or when it has 

completed but some warnings or errors 

were detected 

3. All backups: with any backup, 

whether it was successful or not (as in 

1 and 2 above) 

4. Never: don’t send any email 

notifications  

Message Settings area 

 

Specify the recipient in the To field and change the From address based on your requirements. 

Enter multiple addresses by separating them with semicolons: 

 

Attaching Backup Log information 

 

Attach Backup Logs to the email by selecting either of the two options provided: 

 A summary: select Summary, warnings and errors 

 A full log: select Entire log file 

 

Warning: SMTP servers might have limits on attachment sizes, in which case attachments will not 

be received. This will be indicated in the email though. 

Server Settings area 

1 

2 

3 

4 
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In order to send any email from the Backup Client, a valid SMTP server and port number must be specified.  

Additional settings 

 

 Enable encryption by selecting Encrypt Connection (STARTTLS). 

 If the SMTP server requires authentication, enable the option and specify the username and password. 

 

Tip: Test the connection to the SMTP server by using the Test button. A positive or negative result will be 

displayed depending on whether a connection could be established to the server. 

Backup Schedule 
You can use the Backup Schedule page in the Options and Settings dialog box to: 

 Enable/disable a daily automated backup 

 Create advanced automatic backup schedules 

 

Daily automatic backups are enabled by default unless disabled during the Setup Wizard. If disabled, you can enable it by 

following the instructions below. 
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To enable a daily automated backup: 

1. Select the Daily automated backup check box.  

2. Specify a time in the associated box.  

3. Click Ok. 

To create an advanced backup schedule:  

1. Select the Advanced schedule (back up at the following times) check box.  

2. In the Week day box, select the day on which a backup should be initiated.  

3. Specify the time in the Backup time box.  

4. Click the Add button to add the day and time to the Advanced schedule box.  

5. Repeat steps 2 to 4 above until you have added all desired schedules to the Advanced schedule box.  

To disable automatic backups (not recommended):  

1. Clear the Daily automated backup and Advanced schedule check boxes. 

2. Click Ok to close the Options and Settings dialog box. 

 

Warning: This option is not recommended. If an automated backup schedule is not created, backups will have 

to be run manually. Enabling automatic backups is strongly advised. 

For instructions on how to schedule backups, see Scheduling automatic backups in Chapter 6, “Backups”. 

Backup Scripts 
You can use the Backup Scripts page in the Options and Settings dialog box to: 

 Run a script before data is backed up 

 Run a script after data has been backed up 
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The Backup Scripts page consists of the following areas:  

 Before Backup 

 After Backup 

 

Tip: Scripts such as batch files (with possible Power Shell cmdlets) and EXEs can be executed by the Backup 

Client before and after the backup process. This allows you to get an application ready for backup, like stopping 

or starting services or to prepare data files. 

Run a Script Before Backup 

Specify a single script to be run at the start of a backup, before any data is backed up. 

To enable this option:  

1. Tick the box Run this script before each backup 

2. Enter/Browse for the full path of the script and file name 

 

Note: Any file type can be used. We suggest testing a script prior to using it here. 

3. Click OK to save your changes 

Automatically stop the backup if the script fails 

This option is intended for use when the preparation by running the script before the backup, fails, to prevent the backup from 

going ahead. 

To enable this option:  

1. Tick the box Abort the backup if the exit code is not 0 

2. 2.Click OK to save your changes 

 

Note:  

 The Backup Status window will indicate when a script is running i.e. "RUNNING SCRIPT" 

 Take note of the Backup Logs to see the exit code and verify the success of your backup and scripts 

 

Warning: The backup process will wait for the script to complete before continuing. 
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Run a Script After Backup 

Specify a single script to be run at the end of a backup.  

To enable this option:  

1. Tick the box Run this script after each backup 

2. Enter/Browse for the full path of the script and file name 

 

Note: Any file type can be used. We suggest testing a script prior to using it here. 

3. Click OK to save your changes 

 

Note:  

 The status in the Backup Status window will indicate when a script is running i.e. "RUNNING SCRIPT" 

 Take note of the Backup Logs to see the exit code and verify the success of your backup and scripts 

Global Exclusions 
You can use the Global Exclusions page in the Options and Settings dialog box to: 

 Exclude files globally 

 Exclude folders globally 

 View profiled global exclusions 
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The Global Exclusions page in the Options and Settings dialog box consists of the following areas: 

 Exclude Files  

 Exclude Folders  

 Profiled Exclusions 

Exclude Files area 

In this area, you can specify that files with certain file names, extensions or last modified dates be excluded from all backups.   

To exclude files based on their file names or extensions: 

1. Select the Exclude these files check box. 

2. Type the file name(s) and/or file extension(s) in the box provided; separated by semicolons or listed beneath each 

other.  

 

Tip: You can use wildcards.  E.g. *.mp3 will exclude all MP3 files from backups. 

 

Example: To exclude all MP3 and AVI files, specify *.mp3 and *.avi in the text box.  Separate 

entries with a semicolon or type each on a new line. 

3. Click OK. 

To exclude files based on their 'last modified' dates: 

1. Select the Do not back up files older than check box. 

2. In the box provided, type the date in dd-mm-yyyy format. Alternatively, click the drop-down arrow and select a date.  

3. Click OK. 
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Exclude Folders area 

In this area, you can exclude certain folders from all backups. 

To exclude folders: 

1. Select the Exclude these folders check box. 

2. Type the folder names in the box provided; separated by semi-colons or listed on separate lines.  

 

Note:  

 Wildcards and path separators are not supported in this area. 

 Entries are case sensitive. 

3. Click OK. 

Profiled Exclusions area 

This area will indicate if any file/folder global exclusions have been set by the Backup Administrator. Since profiled settings 

can only be changed from the Storage Platform Console, contact your Backup Administrator if there is a problem with the 

files/folders being excluded. 

 

Note: Profiled exclusions are combined with the user’s exclusions in the Backup Client. However, profiled 

exclusions take precedence over the user’s inclusions. 

For more information, see Profiling in Chapter 10, “Advanced Tools”. 
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Connection 
On the Connection page in the Options and Settings dialog box to configure communication settings, such as:  

 How to handle connection delays and disruptions 

 Using a proxy server to connect to the Storage Platform 

 

The Connection page consists of the following areas: 

 Retries and Timeouts.  

 Proxy Server 

Retries and Timeouts area 

Number of backup or restore retries 

By default, the Backup Client tries to connect to the Storage Platform ten times before cancelling the backup process. 

 

Note: You are advised to increase the number of attempts when using a slow Internet connection. The backup 

will continue from the previous point of failure and not resend the entire backup. 

Duration before connection retries 

By default, the Backup Client will try to reconnect to the Storage Platform after 60 seconds, should the connection be dropped. 

This setting enables you to increase/decrease the duration between retries.  

Socket timeout 
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The default socket timeout is 60 seconds. If the Backup Client is connected to the Storage Platform and there is no 

communication between the two, the time specified in this box (in seconds) is how long the Backup Client will stay connected 

before dropping the connection.  

Proxy Server area 

Here you can specify whether the Backup Client should connect to the Storage Platform through a proxy server. 

To set your Backup Client up to use a proxy server, do the following: 

1. Enable the option Use HTTP proxy 

 

2. Enter the proxy server's details in the boxes provided: 

a. Proxy host 

b. Proxy port 

3. If the server requires authentication, enable the option, Proxy server requires authentication, and enter the 

appropriate credentials: 

a. Username 

b. Password 

 

Note:  

 Connecting through the proxy server will be indicated in the Logs when the backup occurs. 

 An HTTPS connection will be used. 

Network Utilisation 
Network bandwidth usage restrictions can be applied to the Backup Client for when backups take place. To do this, you’ll 

need to: 

1. Define a set of usage limits 

2. Apply those limits to a timetable 

Defining the limits 
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Six limits can be set and are in kilobytes per second (KB/s). Each limit (using the corresponding colour) can then be applied 

to the timetable. 

Applying the limits to the timetable 

 

 

Apply limits by doing the following: 

1. Select a limit from the list. Alternatively, select the limit with “ALT + number of corresponding limit”, e.g. ALT + 

1-6 (“hotkeys”). 

2. Click the allotted timeslot in the diagram provided. Alternatively, also navigate the timetable using the arrow keys 

and pressing SPACE to paint a block. 

 

Note: Timeslots are in segments of an hour in the day, marked from 0 to 24 

3. Repeat the process until all allotted timeslots have been filled with the appropriate colours. 

4. Click OK. 
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Tip: When an arrangement of limits in the timetable becomes too complex to maintain, the grid can 

be reset to its default state, by clicking the Default button, so that new limits can be applied more 

easily. 

 

These limits will be used when the next backup is performed within an affected timeslot.  

Performance 
You can use the Performance page in the Options and Settings dialog box to change settings that influence disk and memory 

usage. 

Disk Usage 

You can use the Disk Usage page in the Options and Settings dialog box to specify the location of working folders.  

 

Working Folders area 

The Data folder is used for storing temporary information used during backup and restore processes. The location of the folder 

is set by default, for example: C:\ProgramData\Redstor Backup Pro\Backup Client ESE\data 

If you have limited space on the drive where the Backup Client is installed, you can specify a different location.  

 

Note:  

 The default location for the Data folder is determined by the “ProgramData” environment variable. 

 Performance will be degraded if the data folder is on a network share. 

 If you move this folder to a network share, ensure that the Backup Client has the correct permissions 

to reconnect and write to that share. 

Advanced Performance 

You can use the Advanced Performance page in the Options and Settings dialog box to configure the settings relating to: 



 

 

70 

Copyright © Redstor Limited. All rights reserved 

 Using VSS 

 Exchange database integrity checking 

 Memory allocation of the Backup Client and related Windows service 

 

The Advanced Performance page in the Options and Settings dialog box consists of the following areas: 

 VSS 

 Exchange (if applicable) 

 Memory Allocation 

 

VSS area 

Use Volume Shadow Copying (VSS) to back up locked files 

Microsoft Volume Shadow Copy Service (VSS) provides a solution by creating a snapshot of data at any given point in time 

without any interruption to any applications. Using this option enables the backup of open or locked files. 

 

Note:  

 For files under heavy use, VSS may increase disk usage during backup. The larger the files, the 

greater the disk usage. 

 If the backup process was unable to read a file using VSS, the Backup Client will continue backing up 

other files. Please review the backup log to identify any files that could not be read.  

 Even if this setting is disabled, VSS will still be used when backing up Microsoft SQL Server 

databases. 

Exchange area 

Check Exchange mailbox database integrity during backup: By selecting the box in the Exchange area, the integrity of 

the Exchange mailbox databases will be verified during the backup process while data is processed and not afterwards – 

without negatively affecting performance. This check includes the “.edb” database files and file headers, as well as whether 

associated logs are corrupt or missing.  
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Note: Should a mailbox database fail any of these checks. The result will be reported in the Backup Log. We 

recommend keeping this setting on in order to identify corrupt mailbox database backups. 

Memory Allocation area  

Use the Backup service and Backup Client interface boxes to set the respective memory amounts. 

 

Note: If you change the backup service amount, you will need to restart the backup service before the change 

takes effect. If you change the Backup Client interface amount, you will need to restart the interface before the 

change takes effect. 

Logging 
You can use the Logging page in the Options and Settings dialog box to specify your logging preferences.  

Modifiable logging settings include: 

 Location of backup and restore logs 

 Level of detail included  

 Log file retention period 

 Debug message inclusion/exclusion in service log 

 

The Logging page in the Options and Settings dialog box consists of the following areas: 

 Backup Logs  

 Service Log  

Backup Logs area 

You can specify where to store the backup and restore logs in the Location box. 
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Note: The default location for the “logs” folder is determined by the “ProgramData” environment variable. 

You can also specify the level of detail to be displayed in the logs by selecting one of these options: 

 All information: Displays all file-level errors, warnings and informational (non-errors/warnings) entries. This could 

cause some informational to be repeated. All skipped, missing or unreadable files will be recorded. 

 Suppress detail: Will display all errors, warnings and purely informational log entries. Only errors and warnings 

could be repeated. 

You can also enable a log file retention period by specifying that the Backup Client delete files older than a particular number 

of days. To do this, select the Delete log files older than (days) check box, and then specify the number of days in the box 

provided. 

 

Tip: To delete all logs older than the specified number of days immediately, click the Delete older logs now 

button. 

Service Log area 

In this area, you can specify whether or not debug messages should be logged. 

Windows Image Backup 
With Windows Image Backup (WIB) enabled all the critical volumes on a Windows machine will be backed up. (A volume 

being a single accessible storage area resident on one or more partitions of one or more physical disks.) These volumes 

contain the operating system and other system-critical data for the operating system to function properly (also known as 

“system” volumes).  

 

Note: Please refer to the “System Compatibility Matrix” document for the earliest supported version of 

Windows Server before using WIB. 

How it works 

The Backup Client leverages off the Windows Server Backup technology. WIB implements the command-line usage of WSB’s 

“wbadmin” command with the “–allCritical” parameter set in order to perform critical volume backups. When the backup 

occurs, all files, including non-system files on critical volumes are temporarily stored in consolidated format in a central 

“dump” destination i.e. a “WindowsImageBackup” folder on the same machine, before being transferred to the Storage 

Platform. Because of this, when the backup is transferred to the Storage Platform, no deduplication is performed (see “SIS 

behaviour” in the Configuring Group Settings section of the Storage Platform Console User Manual). 

Prerequisites for using WIB 
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Use a non-system volume 

The dump destination cannot also be a system volume. When selecting the Dump destination drive letter, ensure that an 

additional volume is available where no system information is stored. (see Enabling Windows Image Backups below)  

Enable Windows Server Backup (WSB) 

To enable WSB: 

1. Open the Server Manager on your Windows server. 

2. For Windows 2008:  

In the selection tree on the left-hand pane, right-click on Features and click Add Features. The Add Features 

Wizard will appear. 

For Windows 2012:  

a. Click Add roles and features while in the Server Manager Dashboard. The Add Roles and Features 

Wizard will appear. 

b. Continue the wizard by following the prompts up to the Features step. 

3. In the Features list, scroll to Windows Server Backup Features, expand the item, and check the Windows Server 

Backup box. 

 

4. Click Next. 

5. Click Install to complete the process. 

A message will indicate that the “Installation succeeded”. You may close the wizard thereafter. 

Enabling Windows Image Backups 

To enable Windows Image Backup: 

1. In the Options and Settings window, select Windows Image Backup. 
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2. Check the All critical volumes box. 

3. Select a valid Dump destination drive letter. 

 

Note: Ensure that the prerequisites mentioned above have been fulfilled. 

4. Click OK. 

The next backup will include the critical volumes for this machine. 

 

Note: Subsequent backups with WIB enabled will update the Storage Platform with incremental changes as 

with normal file and folder backups. 
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10. Advanced tools 
Enterprise Server Edition includes tools that allow advanced users to modify, enhance and streamline the Backup Client and 

also to perform specialised selections of data for backup and restore. 

Backup Snapshots 
The Backup Snapshot feature enables you to create a backup of all items included in your backup selection. This snapshot 

data can then be transferred to the Storage Platform. 

You can use this feature to reduce the initial backup window if there is a large amount of data to be transferred, typically over 

a slow Internet/network connection. A similar procedure enables you to restore a large amount of data (e.g. during a disaster 

recovery). For more information about restore snapshots, see “Restore Snapshots (Disaster recovery)” below. 

 

Note: A snapshot backup uses 256-bit AES encryption and the backup encryption key to encrypt the data. 

 

Warning:  

 This procedure should only be performed with the assistance of the Backup Administrator.  

 Ensure that you have an active Backup Account. 

 It is advised to perform a test backup that transfers only a small amount of data before beginning the 

Backup Snapshot process. 

To export a Backup Snapshot: 

1. On the Tools menu, point to Snapshot, and then click Export Backup Snapshot. 

2. Select The next backup must be a Snapshot backup.  

3. Specify a destination in the box provided (C:\Backups\Export\Snapshot-Backup is specified by default on 

Windows Server 2008 machines.) 

4. In order to do a full backup, select Force a full backup. 

 

Note: A full backup contains the latest full copies of all files included in the backup selection. This facilitates a 

full recovery off all files when restoring this Snapshot. 

5. Click Backup Now.  

Alternatively, if you click OK, the next backup you initiate will be a snapshot backup. 

(A “Snapshot” backup will also be indicated in the Backup Log.) 

The Snapshot data is now stored in the location specified in step 3 above and can be transferred to the Storage Platform i.e. 

the Backup Administrator can import the snapshot data on the StorageServer using the Storage Platform Console. (For more 

information, please refer to the Storage Platform Console User Manual.) 
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Note: The Last Backup on the Restore tab will display grey folders. This means that the data cannot be 

restored until it has been imported on the StorageServer. 

The Backup Account will be disabled at this point preventing any 

further backups to ensure that the Snapshot data is the most 

recent although other data can still be restored. Once the data 

has been successfully imported to the Storage Platform, the 

Backup Account will be enabled automatically and backups can 

proceed as usual. 

 

Tip: If, for some reason, the Snapshot will not be imported, the account can be enabled manually. Please see 

Knowledge Base article 562 for this workaround. 

Restore Snapshots 
The Restore Snapshot feature enables you to restore large amounts of data from a locally connected device to a machine via 

the Backup Client. 

Before you can perform the steps outlined below, the Snapshot data needs to have been exported from the StorageServer to a 

mobile storage device by a Backup Administrator. For more information, please refer to the “Exporting a Backup Snapshot” 

section in the Storage Platform Console User Manual. 

 

Note: A snapshot restore uses 256-bit AES encryption and the backup encryption key to encrypt the data. 

 

Tip:  

 An HSM backup folder can be imported directly by the ESE Backup Client using the Snapshot 

Restore capability. Note that the Snapshot Location will differ when following the steps below. 

 If the Snapshot backup was a “Full” backup, it can be used to restore all files included in the backup 

selection instead of only the modified ones. 

To restore data from a Snapshot: 

1. Connect the mobile storage device containing the snapshot data to the client machine or to a Local Area Network so 

that it has access to the client machine. 

2. On the Tools menu, point to Snapshot, and then click Import Restore Snapshot. 

3. Select the Show Restore Snapshot(s) in Restore panel check box. 

4. Specify the path to the data in the Snapshot location box. 

 

Warning: The default snapshot location specified is: C:\Backups\Import\Snapshot-Restore. If you 

wish to use this location, you need to create the folder structure on the machine and then paste the 

snapshot data onto the Snapshot-Restore folder. This folder is not created automatically. 

Alternatively, you can use the Browse button to browse to the location in which you have saved the 

snapshot data. 

5. Click OK. 

http://partners.redstor.com/faqs/562
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The Snapshot data will display as an entry in the Restore tree, enabling you to browse a directory of its contents and restore 

files and folders. For more information, see Chapter 7, “Restores”. 

Profiling 
Profiling enables your Backup Administrator to propagate certain settings relevant to your Backup Client from the Storage 

Platform. 

It can be used to enforce the following settings: 

 Backup schedules 

 Inclusions and exclusions 

 Filters 

 Most options and settings accessible via the Tools menu 

 

Note: Profiled settings take priority over settings specified in the Backup Client. 

When the Backup Client connects to the Storage Platform, it receives a list of all profiled settings. These 

changes are implemented in the Backup Client. You can, however, connect to the Storage Platform and update 

profiled settings manually. 

To update profiled settings manually: 

1. On the Tools menu, click Options. 

2. On the Backup Account page of the Options and Settings dialog box, click the Retrieve settings button. 

The Backup Client will retrieve any profiled settings from the Storage Platform and update its options and settings accordingly. 

 

Note: Profiled settings are greyed out, and cannot be modified from within the Backup Client. 

Inclusions /exclusions applied by profiling are displayed with specific icons in the Backup Client. See the Icon legend section 

in Chapter 6, “Backups”, for details on identifying profiled files and folder inclusions and exclusion. 

 

Capita SIMS, FMS, and Discover 
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The Backup Client provides specialised backups for educational 

institutions in the United Kingdom that make use of the Capita 

Schools Manager Information System (SIMS). Components used 

by Capita are automatically detected in which case new views will 

be displayed to facilitate related data backups.  

 

 

Backing up SIMS information 

The SIMS view is displayed in the Backup Selection tab when 

SIMS is installed on the computer. 

SIMS Shared Directory 

To include the Shared Directory in the backup selection: 

1. Activate the SIMS view. 

2. In the Manage SIMS section on the left-hand side, click EDIT next to “Backup Configuration” to change the SIMS 

components included in the backup. 

 

3. In the Backup Configuration section that appears on the right-hand side, select the Back Up SIMS Shared 

Directory option. 

 

4. Browse for the folder where the Shared Directory is installed. 

5. Click Save. 

The Backup Configuration section on the left will be updated to indicate “Backing Up SIMS Shared Directory”. The data will 

be included in the next backup. 
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SIMS Document Management Server (DMS) 

To include the Document Management Server in the backup selection: 

1. Activate the SIMS view. 

2. In the Manage SIMS section on the left-hand side, click EDIT next to “Backup Configuration” to change the SIMS 

components included in the backup. 

 

3. In the Backup Configuration section that appears on the right-hand side, select the Back Up SIMS Document 

Management Server option. 

 

4. Browse for the folder where the DMS is installed. 

5. Click Save. 

The Backup Configuration section on the left will be updated to indicate “Backing Up SIMS DMS”. The data will be included 

in the next backup. 
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SIMS databases 

Since the SIMS modules relies on SQL Server databases, those have to be included/excluded explicitly from the SIMS view. 

The process is two-fold: 

a) Add the SIMS SQL Server to the Backup Configuration 

b) Add any database for the server to the Backup Configuration 

a) To add the SIMS SQL Server: 

1. Activate the SIMS view. 

2. In the Manage SIMS section on the left-hand side, click ADD SERVER. 

 

3. In the Add SIMS Server section that appears on the right-hand side, enter the details of the SQL Server that hosts the 

SIMS databases. 

 

4. Also enter the desired folder where database data is to be saved prior to being backed up. 
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Note:  

 A “capita” subfolder will automatically be created in the specified location. 

 This is the folder where all database files will be backed up from which means this location 

will be used when data is searched for in the Restore tab when restoring files.  

Example: 

 

5. Click Save.  

The Backup Configuration section on the left will be updated to indicate that the server has been added. Proceed to add 

databases (described directly below) that should be included in the next backup. 

 

 

Note: Additional servers can be added at this point. Just repeat the process described above. 
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b) To include database associated with the SIMS SQL Server: 

1. In the Manage SIMS section on the left-hand side, directly below the relevant server entry, click ADD DATABASE. 

 

2. In the Add/Remove… section that appears on the right-hand side, select (to include) or deselect (to exclude) 

databases from the backup selection.  

 

 

Note: We suggest including the “master” database since foundational information about your 

databases is usually kept there. 

3. Click Save. 

The Backup Configuration section will be updated to reflect the “Databases Selected for Backup”, listing the included 

databases. 
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Note: Additional database selection changes can be done at this point. Just repeat the process described above. 

Backing up FMS and Discover information 

The process for including and excluding information of the FMS and Discover components is the same as that of SIMS. 

Follow the steps as described under SIMS databases earlier in this chapter.  
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15. Reference 

Keyboard shortcuts and hotkeys 

Keys Action 

F5 Refresh the active window 

SPACEBAR x1 Include selected file/folder 

SPACEBAR x2 Exclude selected file/folder 

SPACEBAR x3 Clear inclusion/exclusion 

SHIFT+/ Select multiple files 

ALT+Underlined letter on menu bar Open the corresponding menu 

 Select previous item, or scroll up if you are in the Logs tab 

 Select previous item, or scroll down if you are in the Logs tab 

Page Up Scroll up one page 

Page Down Scroll down one page 

Home Scroll to the beginning of the page if you are in the Logs tab 

End Scroll to the end of the page if you are in the Logs tab 

 

 

 


